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Welcome to your zipForm® 6 Professional Administrator Account!
zipForm® 6 Professional offers many powerful tools to allow administrators to customize their accounts.
Administrative features may be accessed at any time by clicking on the Agent List and Office List tabs
located in the Home main tab.

Home main tab – contains all
of the Administration features

Forms main tab – contains all of the
form and transaction features

Figure 1

Agent List tab – this is where
you manage users

Office List tab – this is where
you manage office locations

Office List Tab
Not every brokerage will require multiple offices. If you will use multiple offices in your brokerage account, it
is important to set them up before you create users. The reason is that you will be required to associate your
users with an office when they are created.
All zipForm® 6 Professional brokerage accounts will have at least one office – this being the Corporate
Office that is created by zipLogix to open your account.
If you intend that all of your agents will operate out of a single office, you can attach all of your users to the
Corporate Office, and you will not need to create additional offices. If this is the case you can skip ahead to
the “Users – Agent List” section below starting on page 7.

Adding Offices (Figures 2 and 3)
If you are going to use multiple offices to manage your users, it is important to add these offices before
adding users.
To add an office to your zipForm® 6 Professional account you must have available seats. “Seats” is a term
used to describe the number of users that can be attached to the brokerage account – one office, one seat.
When all of the seats are “filled”, the Broker Administrator cannot add more offices until some offices are
removed. You may purchase additional office seats if necessary by calling 866-627-4729.
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Step 1: To add an office to your brokerage account,
click on the Office List tab.
Figure 2

Step 2: On the Office List tab, click on the Add Office button.

Step 3: On the General Information page you will be able to fill in information about
the office: name, address, city, state, zip, phone, toll free phone and fax.
Figure 3

Step 4: Click on the Save button to store the new office or click on the Cancel
button to return to the Office List page without saving anything.
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Finding an Office (Figure 4)
When you log into zipForm® 6 Professional as an administrator, you are placed in the Agent List tab by
default. However, you can access your Office List by clicking on the Office List tab.
Offices may be found by their name, address, agent’s username or status using the Advanced Search. Most,
if not all offices will be “Office/Location” status.
Find a specific office by filling in some criteria in one or more of the fields provided. You can use partial
values in these fields. You can use the Reset button to reset the filters to their default state.

Search – type an office
name to search for

Office List tab – this is where
you manage office locations
Figure 4

Advanced Search – click
to open additional search

Reset button –
clears all fields

Working with Office Actions (Figure 5)
On the Office List tab, you can choose an action to operate on a specified office. To the left of each office on
the list is a drop-down arrow. Move your mouse pointer over these drop-down arrows, next to the office you
wish to perform an action on.
View

Opens the View Office page. You can view the office information, but you cannot
edit it. Click OK to return to the Office List tab.

Edit

Opens the Edit Office page. You can edit any of the office information. Click the
Save button to make the change or click Cancel to return to the Office List rejecting
all changes.

Delete

Opens the Delete Office page. You can view the office information and delete the
office if desired. Click the Delete button to remove the office or click Cancel to return
to the Office List without deleting anything.
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Changing Office Information (Figure 5)
As a Broker Administrator you can use the Office List tab to find the offices linked with your brokerage
account. By choosing the Edit action, you can change any of the office information including the name.
The changes made will only take effect on new transactions. Existing transactions will print the office
information that the user was assigned to at the time that the transaction was created.

Office List tab – this is where
you manage office locations
Figure 5

View action – this action allows
you to view office information

Edit action – this action allows
you to edit office information

Delete action – this action allows you to delete an office
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Users – Agent List Tab
On the Agent List page, an Office Administrator will see all agents who are associated only with the
Corporate Office, and all agents associated with their office. A Broker Administrator will see all agents
regardless of office.

User Roles
Broker Administrators – A zipForm® 6 Professional brokerage account consists of some number
of users and – optionally – offices with a Broker Administrator managing them.
The Broker
Administrator is responsible for managing users, offices, templates and clauses. The Broker
Administrator also has the ability to generate reports on users, view user transactions and reassign
them to other users.
Office/Location Administrators – In large brokerages, it may not be practical to have only one
administrator managing the account, so the brokerage account can be subdivided into Offices. Each
Office will have its own Office/Location Administrator who has the ability to manage users, templates
and clauses within their office. Each office may have multiple Office/Location Administrators; also
one Office/Location Administrator may manage more than one office. Office/Location Administrators
only have the ability to manage users and templates that are in the offices to which they are
assigned. Only the Broker Administrator has the capability to manage all users, templates and
clauses within all offices.
Agents – Agents are not administrators, however, they do have some control over their own
accounts and transactions.

Adding Users (Figure 6 and 7)
To add users to your zipForm® 6 Professional account you must have available seats. “Seats” is a term
used to describe the number of users that can be attached to the brokerage account – one user, one seat.
When all of the seats are “filled”, the Broker Administrator cannot add more users until some users are
removed. You may purchase additional seats if necessary by calling 866-627-4729.
At least one administrator must always be associated with an office. A user may be an administrator in
multiple offices, and an office may have multiple administrators.

Step 1: To add a user to your brokerage account, click on the Agent List tab.
Figure 6

Step 2: On the Agent List tab, click on the Add Agent button.
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Step 3: On the General Information page you will be able to fill in information about the user: role, first name, last name, email
address, zipForm login username, phone, extension, fax, which office they are a part of, which form libraries the user will be
assigned, and whether or not you wish to send the user an email invitation. The Portal Login Id field should be left blank unless
your account belongs to a specific portal.

Figure 7

Step 4: Click on the Save button to store the new user or click on the Cancel button to return to the Agent List page without saving
anything. When a new user is added, the password is blank by default. The new user must log in with the username that you created for
them, leave the password field blank, and click on the “Sign In” button. They will then be prompted to create a password for their
account.
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Finding Users (Figure 8)
Agents may be found by their email address, first name, last name, office or status using the Advanced
Search. Find a specific agent by filling in some criteria in one or more of the fields provided. You can use the
Reset button to reset the filters to their default state.
Each user is color-coded to match the role that each user fulfills. A Broker Administrator is shown in pink, an
Office Administrator is shown in blue and all other users are shown in green.

Agent List tab – this is where
you manage users
Figure 8

Search – type an office
name to search for

Advanced Search – click to
open additional search options

Reset button –
clears all fields

Working with Agent Actions (Figure 9)
On the Agent List tab, you can choose an action to operate on a specified agent. To the left of each agent on
the list is a drop-down arrow. Move your mouse pointer over these drop-down arrows, next to the agent you
wish to perform an action on.
Whenever you delete a user, please be aware that all transactions in the user’s account are reassigned to
the Broker Administrator. User transactions are not automatically deleted when the user account is removed.
The Broker Administrator will find these transactions on their transaction list where the transactions can be
deleted or reassigned to another user. A good rule to follow before you delete a user is to first inspect the
user’s account and take a look at the transactions (if any). Delete or reassign these transactions before you
delete the user’s account.
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View

Opens the View Agent page. You can view the agent’s information, but you
cannot edit it. Click OK to return to the Agent List tab.

Edit

Opens the Edit Agent page. You can edit the agent’s information. Click the
Save button to make the change or click Cancel to return to the Agent List
rejecting all changes.

Reset Password

Resets the password for the selected agent.

Delete

Opens the Delete Agent page. You can view the agent’s information and
delete the agent if desired. Click the Delete button to remove the agent or
click Cancel to return to the Agent List without deleting anything.

Transactions

This action is available to the Broker and Office Administrators. For the
agent selected, this action opens the agent’s list of transactions where they
may be opened and inspected.

View action – this action allows
you to view an agent’s
information

Edit action – this action allows
you to edit an agent’s
information

Agent List tab – this is where
you manage users
Figure 9

Delete action – this action
allows you to delete an office

Edit action – this action allows
you to edit office information

Reset Password – this action allows
you to reset a user’s password

Reassigning Transactions (Figures 10, 11, and 12)
One of the important capabilities of the administrator is to reassign transactions.
For example, when an agent is removed (deleted) from zipForm® 6 Professional, all of the agent’s
transactions are automatically reassigned to the Broker Administrator. A good rule to follow before you
delete a user is to first inspect the user’s account and take a look at the transactions (if any). Delete or
reassign these transactions before you delete the user’s account.
Other reasons to reassign transactions may be an agent on leave or disability, or maybe a transaction or
referral coordinator will take over the process.
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Step 1: To reassign a user’s transaction to another
user, click on the Agent tab.

Step 2: Search for the user whose transactions you
wish to reassign.
Figure 10

Step 3: Use the Transactions action by clicking on the drop down arrow
next to the user whose transactions you wish to reassign.

Step 4: You will now be placed in the user’s transaction list that you selected in Step 3. Search for the transaction that you wish
to reassign.
Figure 11

Step 5: Use the Reassign action by clicking on the drop down arrow next to the transaction you wish to reassign.
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Step 6: Select the user you wish to reassign the
transaction to.
Figure 12

Step 7: Click on the Reassign button to reassign the transaction to the selected user, or click on the Cancel button to return to
the user’s transaction list.

Moving Agents Between Offices (Figures 13 and 14)
It is possible to move users from one office to another with the same Broker account. You cannot move an
agent from a separate account into your account.
When a Broker Administrator logs in, the Agent List is the default view where they can see all of the users in
the brokerage and all of the offices. The Agent List is also the default view of an Office Administrator.
However, an Office Administrator can see users assigned solely to the Corporate Office in addition to users
assigned to the office.
Step 1: To move a user into an office, click on the Agent tab.
Figure 13

Step 2: Use the Edit action by clicking on the drop down arrow next to the user you wish to move.
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Step 3: Under “Office Information” you will see a list of the offices available. Simply place a check next to the office you wish to
assign the user to, or uncheck the box if you wish to remove the user from that office. You cannot remove the check from the
Corporate Office.
Figure 14

Step 4: Click on the Save button to save your changes, or click on the Cancel button to return to the Agent List tab.
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Managing Passwords (Figures 15, 16, and 17)
In addition to the “Send Invitation Email” message received by a newly set up user,
er, there are other ways to
manage passwords. The Reset Password action is found in the Agent List tab.
This action is used to reset a user’s password. Once the password has been reset, the user will be sent an
email to the email address on the account. This email will contain a link. When the link is clicked, the user
will be prompted to create a new password.

Step 1: To reset a user’s password, click on the
Agent tab.

Step 2: Search for the user whose password you
wish to reset.
Figure 15

Step 3: Use the Reset Password action by clicking on the drop down
arrow next to the user whose password you wish to reset.
Figure 16

Step 4: Click on the Reset Password button to reset the user’s password, or click on the Cancel button to return to the Agent List tab
without resetting a password.
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The user can also reset the password themselves by clicking on the “Forgot Password” link on the zipForm®
6 Professional log in page. The user will receive an email at the email address on the user account. This
email will contain a link to the Set Password page.
Figure 17

Click on the Forgot Password link to reset your password.

Templates
A template is a group of forms that you frequently use for your transactions. This packet of forms can have
non-specific transaction data stored within the template. As an example, you can create a template that
contains the forms required for a listing, your company and your agent information.

Once you have created a template you can either start a transaction using the template or apply a
template to one of your existing transactions.

Creating Templates (Figures 18 and 19)
Templates may be created at the global, office or agent level.
The three template statuses are:
Global Template – A Global Template is a template that all users will see and be able to use. Only
a Broker Administrator can create this level of template.
Location/Office Template – A Location or Office Template is a template that only users from a
certain office will see and be able to use. An Office Administrator or Broker Administrator can create
this level of template.
Agent Template – An Agent Template is a template that only the agent that created it can see and
use. All users (including administrators) may create and use their own templates at this level.
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Step 1: Click on the Forms main tab to get access to the form and transaction options.
Figure 18

Step 2: Click on the Template button in the File tab.

Step 3: When the drop down menu appears, click on
Create Template.
Figure 19

Step 4: Enter a name for the Template.

Step 5: Select the Template, Property type, and
Status.

Clause Editor
By using the Clause Editor, an administrator may create and store “Office” or “Broker” clauses. Agents
cannot create or edit clauses at these levels but they can apply them. Office clauses are available only to
users assigned to a specific Office. Broker clauses, on the other hand, are available to all users in the
organization.
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Managing Clauses (Figures 20, 21 and 22)
In the Clause Editor you can manage clauses using the following general procedure:
cedure:
Choose the level you want to work with:
Broker – An Office Administrator and Broker Administrator can both create Broker clauses.
Office – When using the Office level, you must choose an Office. An Office Administrator can
choose the Corporate Office and the Office with which they are associated. A Broker Administrator
can choose from all Offices.
Agent – All users (including administrators) may create and use their own clauses at the Agent
level. Only the individual agent can access and use Agent clauses.
Step 1: Click on the Forms main tab to get access to the form and transaction options.
Step 2: Click on the Edit tab.
Figure 20

Step 3: Click on the Clauses button in the Edit tab.

Step 4: Click on the New Clause button.
Figure 21
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Step 5: Select the Clause
Level described above.
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Figure 22

Step 6: Select an existing
Category or create a new one.

Step 7: Type in the Title for the
Clause.

Step 8: Type in the text for the
Clause.

Reports
There are reporting tools available for Broker Administrators. Currently the reports that are available are:
Seats By Library, Transactions By Location, Transactions By User and Users Transactions By Location.

Running Reports (Figure 23)
To access reports, click on the Reports tab within the Home main tab of zipForm® 6 Professional.
Step 1: Click on the Reports tab.

Step 2: Click on the drop down menu labeled
“Select a Report” to choose the type of report you
would like to run.

Figure 23

Step 3: You can click on the “Advanced Search” link to run a report
based on start and end dates and Locations/Offices.
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Product Support Information
Product support is available from our Help Desk only to registered zipForm® 6 users between the hours of
8:00 a.m. and 8:00 p.m. Eastern Time Monday through Friday.
HelpDesk:
http://support.ziplogix.com
Fax Number :: 586-790-7582

Sales:
Email :: sales@ziplogix.com
Fax Number :: 586-790-7582

Mailing Address:
zipLogix
18070 15 Mile Road
Fraser, MI 48026

zipForm Internet Site:
www.ziplogix.com

www.ziplogix.com
©2010 zipLogix. All rights reserved..

18

